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Relevant products 

Product name Model Item number 

PCAN-ISA Single Channel One CAN channel IPEH-002074 

PCAN-ISA Dual Channel Two CAN channels IPEH-002075 

PCAN-ISA Single Channel 
opto-decoupled 

One CAN channel, galvanic 
isolation for CAN connection 

IPEH-002076 

PCAN-ISA Dual Channel 
opto-decoupled 

Two CAN channels, galvanic 
isolation for CAN connections 

IPEH-002077 

 

The cover picture shows the product PCAN-ISA Dual Channel opto-decoupled. Other 
product versions have an identical form factor but vary in equipment. 

PCAN® ist eine eingetragene Marke der PEAK-System Technik GmbH. CANopen® 
und CiA® sind eingetragene Gemeinschaftsmarken des CAN in Automation e.V. 

Product names mentioned in this manual may be the trademarks or registered 
trademarks of their respective companies. They are not explicitly marked by “™” and 
“®”. 

Copyright © 2019 PEAK-System Technik GmbH 
Duplication (copying, printing, or other forms) and the electronic distribution of this 
document is only allowed with explicit permission of PEAK-System Technik GmbH. 
PEAK-System Technik GmbH reserves the right to change technical data without 
prior announcement. The general business conditions and the regulations of the 
license agreement apply. All rights are reserved. 
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Fax: +49 (0)6151-8173-29 
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1 Introduction 

The PCAN-ISA card enables simple, cost-effective connection of 
computer systems with ISA slots to CAN networks. Multiple PCAN-
ISA cards can easily be operated using interrupt sharing. 

The card is available as a single or dual-channel version. The opto-
decoupled versions also guarantee galvanic isolation of up to 500 
Volts between the PC and the CAN sides. 

The monitor software PCAN-View and the programming interface 
PCAN-Basic for the development of applications with CAN 
connection are included in the scope of supply. 

Device drivers exist for different operating systems, so programs 
can easily access a connected CAN bus. 

Note: This manual refers to different versions of the PCAN-ISA 
card. Differences at use and at the technical specifications are 
mentioned accordingly in this manual. 

Tip: At the end of this manual (Appendix B) you can find a 
Quick Reference with brief information about the installation 
and operation of the PCAN-ISA card. 

1.1 Properties at a Glance 

 PC plug-in card for 16-bit ISA slots 

 Multiple cards can be operated in parallel in a single PC 
(interrupt sharing) 

 13 port and 8 interrupt addresses are available for configuration 
using jumpers 
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 1 or 2 High-speed CAN channels (ISO 11898-2) 

 Bit rates from 5 kbit/s up to 1 Mbit/s 

 Compliant with CAN specifications 2.0A (11-bit ID) and  
2.0B (29-bit ID) 

 Connection to CAN bus through D-Sub slot bracket, 9-pin (in 
accordance with CiA® 303-1) 

 NXP SJA1000 CAN controller, 16 MHz clock frequency 

 NXP PCA82C251 CAN transceiver 

 5-Volt supply to the CAN connection can be connected through a 
solder jumper, e.g. for external bus converter 

 Galvanic isolation on the CAN connection up to 500 V (only 
opto-decoupled versions), separate for each CAN channel 

 Extended operating temperature range from -40 to 85 °C  
(-40 to 185 °F) 

Note: This manual describes the use of the PCAN-ISA card with 
Windows. You can find device drivers for Linux and the 
corresponding information on PEAK-System's website under 
www.peak-system.com/linux. 

1.2 System Requirements 

 An empty ISA slot (16 bit) in the computer 

 Operating system Windows 10, 8.1, 7 (32-bit)  
or Windows CE 6.x (x86 and ARMv4 processor support)  
or Linux (32/64-bit) 

http://www.peak-system.com/linux�
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1.3 Scope of Supply 

 Plug-in card PCAN-ISA 

 Slot bracket with D-Sub connectors for the CAN bus 

 Device drivers for Windows 10, 8.1, 7 (32-bit) and  
Linux (32/64-bit) 

 Device driver for Windows CE 6.x  
(x86 and ARMv4 processor support) 

 CAN monitor PCAN-View for Windows 

 CAN monitor PCAN-View for DOS 

 Programming interface PCAN-Basic for developing applications 
with CAN connection 

 Programming interfaces for standardized protocols from the 
automotive sector 

 Manual in PDF format 
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2 Configuration and 
Installation 

2.1 Configuring the Card 

Before you install the PCAN-ISA card into the computer you may 
need to configure it. For each CAN channel an interrupt (IRQ) and an 
I/O address range is set for operation in the computer. 

At delivery the PCAN-ISA card has the following default settings: 

CAN channel IRQ I/O address range Remark 

1 10 300h – 31Fh  

2 5 320h – 33Fh Only on the Dual Channel version 
 

Tip: If the given resources are not firmly occupied by other 
devices, you can skip the configuration and directly continue 
with the following manual section 2.2. 

For a configuration differing from the default settings you need to 
set jumpers on the PCAN-ISA PCB according to the following 
explanations. 

Attention! Electrostatic discharge (ESD) can damage or destroy 
components on the card. Take precautions to avoid ESD when 
handling the card. 

2.1.1 Position of the Jumper Fields 

The single-channel version of the PCAN-ISA card has two jumper 
fields, one for the setting of the I/O address range and one for the 
setting of the interrupt (Figure 1). Accordingly the Dual Channel 
version has the doubled layout (Figure 2). 
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Figure 1: PCAN-ISA Single Channel – Position of the jumper fields for setting  

the I/O address range (JP1, left marker)  
and the interrupt (JP3, right marker) 

 
Figure 2: PCAN-ISA Dual Channel – Position of the jumper fields for setting  

the I/O address ranges (JP1, JP2, left marker)  
and the interrupts (JP3, JP4, right marker) 

2.1.2 I/O Address Range 

Each CAN channel must be assigned to an unique I/O address range 
in the computer. An address space from 200h up to 39Fh (h = 
hexadecimal) is available. The PCAN-ISA card uses 32 addresses 
beginning from the configured base address. The configuration is 
done on jumper field JP1 for CAN channel 1 and jumper field JP2 
for CAN channel 2 (latter only with the Dual Channel version). 
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The following table shows the possible settings. The X stands for a 
set jumper. The default settings at delivery for CAN channels 1 and 
2 are highlighted. 

Jumper field JP1/JP2 

A B C D E 
I/O address range 

X     200h – 21Fh 

X    X 220h – 23Fh 

X   X  240h – 25Fh 

X   X X 260h – 27Fh 

X  X   280h – 29Fh 

X  X  X 2A0h – 2BFh 

X  X X  2C0h – 2DFh 

X  X X X 2E0h – 2FFh 

X X    300h – 31Fh 

X X   X 320h – 33Fh 

X X  X  340h – 35Fh 

X X  X X 360h – 37Fh 

X X X   380h – 39Fh 

2.1.3 Interrupt 

An interrupt (IRQ) must be assigned to each CAN channel. The 
PCAN-ISA card supports the interrupts 3, 4, 5, 7, 10, 11, 12, and 15. 
The default setting at delivery for CAN channel 1 is interrupt 10, for 
CAN channel 2 interrupt 5. 

It is possible to share the same interrupt between two existing CAN 
channels. Therefore you can configure the same interrupt, when 
using two PCAN-ISA cards in the same computer. 

Tip: We suggest to configure different interrupts as long as 
resources allow it and use interrupt sharing only, if this is not 
the case. 
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2.2 Installing the Software 

Install the driver before you install the card. 

Do the following to install the driver: 

1. Start Intro.exe from the supplied DVD. 

The navigation program starts. 

2. Select in the main menu Drivers and click on Install now. 

3. Confirm the message of the User Account Control related to 
"Installer database of PEAK Drivers". 

The driver setup starts. 

4. Follow the program instructions until the Costum Setup is 
displayed. 

 
Figure 3: Driver selection in the PEAK-Drivers Setup 

5. Deselect the CAN device drivers and select CAN device 
drivers Non-Plug-and-Play (see Figure 3). 
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Node: The CAN device drivers Non-Plug-and-Play is only 
available under 32-bit Windows. PCAN-ISA does not work 
under 64-bit Windows. 

6. Follow the further instructions. 

2.3 Installing the Hardware 

Do the following to install the PCAN-ISA card into the computer: 

1. Turn off the computer. 

2. Open the computer case and plug the PCAN-ISA card into 
an empty slot on the computer's motherboard. 

3. In the computer replace a slot bracket with the supplied slot 
bracket containing the D-Sub connector(s) for the CAN bus, 
if applicable. 

4. For each CAN channel connect the flat cable to the 
corresponding connector on the card. 

You can look up the pin assignment of the 10-pin CAN 
connectors on the card in section 3.1. 

5. Close the computer's casing. 

Note: Before switching on the computer, please follow the 
procedure for modifying the computer's BIOS settings 
described in the following section. 
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Figure 4: Connectors for the cable(s) to the slot bracket (here: PCAN-ISA Dual 

Channel, the Single Channel version only has the left connector Ch1) 

2.4 Modifying the Computer's BIOS Settings 

To ensure a flawless operation of the PCAN-ISA card it is necessary 
that you adjust settings in the BIOS setup of the computer: 

 Indicate used interrupts 

 Deactivate the APIC mode 

Note: Due to a diversity of existing BIOS setup versions for 
computers we cannot give detailed instructions here. Instead 
we indicate common setting names. 

In order to know how to start the computer's BIOS setup please 
consult the corresponding documentation. Usually you can enter 
the BIOS setup by pressing the  Del  or  F2  key shortly after 
switching on the computer. 

2.4.1 Indicating Used Interrupts 

By indicating the interrupts that are set on the PCAN-ISA card, you 
avoid that the corresponding resources are automatically assigned 
to other devices and that this results in conflicts. 
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In the BIOS setup itself you can often find the settings for the 
interrupts under a menu item containing the text PnP. For the 
interrupt(s) used by PCAN-ISA change the setting to Reserved or 
Legacy ISA. 

2.4.2 Deactivating the APIC Mode 

Note: Do not mix up APIC with ACPI. 

The APIC mode is a certain type of interrupt management in a 
computer. 

If the APIC mode is active in your computer, you must deactivate it 
so that the PCAN-ISA card can work properly with interrupts. 

Do the following to determine in Windows if the APIC mode is 
active: 

1. Open the Windows Device Manager. 

2. Select the menu entry View > Resources by type. 

3. Open the branch of Interrupt request (IRQ). 

If entries with interrupt numbers greater than 15 are listed, 
the APIC mode is active and you must deactivate it. 

Do the following to deactivate the APIC mode: 

Attention! When you deactivate the APIC mode in the BIOS 
setup, it may happen that you must reinstall Windows 
afterwards, because it cannot start anymore due to the low-
level setting. 

1. Restart the computer and switch to the BIOS setup. 

2. Search for the APIC setting and deactivate it. 

3. Save the changes in the BIOS and quit the BIOS setup. 
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4. If Windows doesn't start properly, reinstall it or perform a 
repair installation. 
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3 Connecting a CAN Bus 

3.1 Connection over D-Sub connector 

A High-speed CAN bus (ISO 11898-2) is connected to the 9-pin 
D-Sub connector. The pin assignment corresponds to the 
specification CiA® 303-1. 

 
Figure 5: Pin assignment High-Speed-CAN  
(view onto connector of the slot bracket) 

Low power devices (e.g. bus converters) can be supplied directly 
with 5 volts over pin 1 and/or pin 9 of the CAN connector. Pin 1 
and/or pin 9 are not in use at the delivery state. For more 
information see the next section 3.2. 

Tip: You can connect a CAN bus with a different transmission 
standard via a bus converter. PEAK-System offers different bus 
converter modules (e.g. PCAN-TJA1054 for a Low-speed CAN 
bus according to ISO 11898-3). 
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The pin assignment between the D-Sub port and the 10-pin 
connector on the PCAN-ISA card is as follows: 

 
Figure 6: Numbering at the 10-pin connector 

Pin Assignment Assignment D-Sub 

1 +5 V (optional) 1 

2 GND 6 

3 CAN_L 2 

4 CAN_H 7 

5 GND 3 

6 not connected 8 

7 not connected 4 

8 +5 V (optional) 9 

9 not connected 5 

10 not connected  
 

3.2 Voltage Supply for External Devices 

External devices with low power consumption (e.g. bus converters) 
can be directly supplied via the CAN connector (independently for 
each CAN connector on the Dual Channel version). With a solder 
bridge on the PCAN-ISA card, a 5-Volt supply can optionally be 
routed to pin 1 and/or pin 9 of the D-Sub connector. 

The opto-decoupled versions of the PCAN-ISA card contain an 
interconnected DC/DC converter. Therefore, the current output is 
limited to about 50 mA. 
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Do the following to activate the voltage supply: 

Risk of short circuit! Solder with great care to avoid unwanted 
short circuits on the card. 

Attention! Electrostatic discharge (ESD) can damage or destroy 
components on the card. Take precautions to avoid ESD. 

Set the solder bridge(s) on the card according to the desired set-
tings. 

Figure 7 shows the positions on the card; the table below contains 
the possible settings. 

 
Figure 7: Position of the solder bridge fields for the 5-Volt supply 

5-Volt supply 
D-Sub connectors 

Solder 
fields Without 

(standard) 
Pin 1 Pin 9 Pin 1 

and 9 

CAN 1 JP5 

    
CAN 2 JP6 

    
 

Risk of short circuit! The 5-Volt supply is not protected 
separately. Therefore, turn off the computer before you 
connect and disconnect CAN cables or peripheral systems. 
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3.3 Cabling 

3.3.1 Termination 

The High-speed CAN bus (ISO 11898-2) must be terminated with 
120 ohms at both ends. The termination prevents interfering signal 
reflections and ensures the proper operation of the transceivers of 
the connected CAN nodes (CAN interfaces, control devices). 

The PCAN-ISA adapter does not have an internal termination. Use 
the adapter on a terminated CAN bus. 

3.3.2 Example of a Connection 

 
Figure 8: Simple CAN connection 

This example shows a connection between the PCAN-ISA adapter 
and a control unit. The connection cable is terminated with 120 
ohms at both ends. 
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3.3.3 Maximum Bus Length 

High-speed CAN networks have bit rates up to 1 Mbit/s. The 
maximum bus length primarily depends on the bit rate. 

The following table shows different maximum possible CAN bus 
length with different bit rates: 

Bit rate Bus length 

1 Mbit/s 40 m 

500 kbit/s 110 m 

250 kbit/s 240 m 

125 kbit/s 500 m 

50 kbit/s 1.3 km 

20 kbit/s 3.3 km 

10 kbit/s 6.6 km 

5 kbit/s 13.0 km 
 

The listed values have been calculated on the basis of an idealized 
system and can differ from reality. 
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4 Software and API 

This chapter covers the provided software PCAN-View and the 
programming interface PCAN-Basic. 

4.1 Monitor Software PCAN-View 

PCAN-View is simple Windows software for viewing, transmitting, 
and logging CAN and CAN FD messages. 

Note: This chapter describes the use of PCAN-View with a CAN 
adapter. 

 

Figure 9: PCAN-View for Windows 
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Do the following to start and initialize PCAN-View: 

1. Open the Windows Start menu and select PCAN-View. 

The Connect dialog box appears. 

 
Figure 10: Selection of the hardware and parameters 

2. Select an interface from the list and continue with step 7. 

3. If no entry is in the list, press the button Add. 

The dialog box Add CAN hardware appears. 

 
Figure 11: Selection of a hardware type 
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4. Select PEAK ISA-CAN SJA. 

5. Enter the port address and the interrupt of the used parallel 
interface established before (see section 2). 

6. Confirm your input with OK. 

7. From the drop-down list, select the Bit rate that is used by 
all nodes on the CAN bus. 

Tip: You can create custom bit rates by using the button (). 

8. Under Filter settings you can limit the range of CAN IDs to 
be received, either for standard frames (11-bit IDs) or for 
extended frames (29-bit IDs). 

9. Activate the Listen-only mode if you do not actively 
participate in the CAN traffic and just want to observe. This 
also avoids an unintended disruption of an unknown CAN 
environment (e.g. due to different bit rates). 

10. Confirm the settings in the dialog box with OK. The main 
window of PCAN-View appears (see Figure 12). 
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4.1.1 Receive/Transmit Tab 

 
Figure 12: Receive/Transmit Tab 

The Receive/Transmit tab is the main element of PCAN-View. It 
contains two lists, one for received messages and one for the 
transmit messages. The CAN data format is hexadecimal by default. 

Do the following to transmit a CAN message with PCAN-View: 

1. Select the menu command Transmit > New Message 
(alternatively  or  Ins ). 

The New Transmit Message dialog box appears. 

 
Figure 13: Dialog box new transmit message 
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2. Enter the ID, the data Length, and the CAN message Data. 

Note: With the program version 4 of PCAN-View, the DLC field 
was renamed to Length. Latter reflects the actual data length. 

3. Enter a value into the Cycle Time field to choose manually 
or periodically message transmission. Enter a value greater 
than 0 to transmit periodically. Enter the value 0 to transmit 
only manually. 

4. Confirm the entries with OK. 

The created transmit message appears on the 
Receive/Transmit tab. 

5. Trigger selected transmit messages manually with the menu 
command Transmit > Send (alternatively  Space  bar). The 
manual transmission for CAN messages being transmitted 
periodically is carried out additionally. 

Tip: Under the menu command File > Save, you can save the 
current transmit messages into a transmit list. Saved transmit 
lists are available for reuse. 
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4.1.2 Trace Tab 

 
Figure 14: Trace Tab 

On the Trace tab, the data tracer (data logger) of PCAN-View is used 
for logging the communication on a CAN bus. During this process 
the messages are cached in the working memory of the PC. 
Afterwards they can be saved to a file. 

The Tracer runs either in linear or in ring buffer mode. The linear 
buffer mode stops the Tracer as soon as the buffer is full. The ring 
buffer mode overwrites the oldest messages by new ones as soon 
as the buffer is full. 
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4.1.3 PCAN-ISA 

 
Figure 15: PCAN-ISA tab 

The PCAN-ISA tab contains some detailed information about the 
hardware and driver. 

4.1.4 Status Bar 

 
Figure 16: Display of the Status Bar 

The status bar shows information about the current CAN 
connection, about error counters (Overruns, QXmtFull) and shows 
error messages. 

You can find further information about the use of PCAN-View in the 
help which you can invoke in the program via the Help menu or 
with the  F1  key. 
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4.2 Linking Own Programs with PCAN-Basic 

 
Figure 17: PCAN-Basic 

On the provided DVD, you can find files of the PCAN-Basic 
programming interface in the directory branch Develop. This API 
provides basic functions for linking own programs to CAN and CAN 
FD interfaces by PEAK-System and can be used for the following 
operating systems: 

 Windows 10, 8.1, 7 (32/64-bit) 

 Windows CE 6.x (x86/ARMv4) 

 Linux (32/64-bit) 
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The API is designed for cross-platform use. Therefore software 
projects can easily ported between platforms with low efforts. For 
all common programming languages examples are available. 

Beginning with version 4, PCAN-Basic supports the new CAN FD 
standard (CAN with Flexible Data Rate) which is primarily 
characterized by higher bandwidth for data transfer. 

4.2.1 Features of PCAN-Basic 

 API for developing applications with CAN and CAN FD 
connection 

 Access to the CAN channels of a PCAN-Gateway via the new 
PCAN-LAN device type 

 Supports the operating systems Windows 10, 8.1, 7 (32/64-bit), 
Windows CE 6.x, and Linux (32/64-bit) 

 Multiple PEAK-System applications and your own can be 
operated on a physical channel at the same time 

 Use of a single DLL for all supported hardware types 

 Use of up to 16 channels for each hardware unit 
(depending on the PEAK CAN interface used) 

 Simple switching between the channels of a PEAK CAN interface 

 Driver-internal buffer for 32,768 messages per CAN channel 

 Precision of time stamps on received messages up to 1 μs 
(depending on the PEAK CAN interface used) 

 Supports PEAK-System‘s trace formats version 1.1 and 2.0 (for 
CAN FD applications) 

 Access to specific hardware parameters, such as listen-only 
mode 

 Notification of the application through Windows events when a 
message is received 
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 Extended system for debugging operations 

 Multilingual debugging output 

 Output language depends on operating systems 

 Debugging information can be defined individually 

Tip: An overview of the API functions is located in the header 
files. You can find detailed information about the PCAN-Basic 
API on the provided DVD in the text and help files (file name 
extensions .txt and .chm). 

4.2.2 Principle Description of the API 

The PCAN-Basic API is the interface between the user application 
and device driver. In Windows operating systems this is a DLL 
(Dynamic Link Library). 

The sequence of accessing the CAN interface is divided into three 
phases: 

1. Initialization 

2. Interaction 

3. Completion 

Initialization 

A channel must be initialized before using it. This is done by the 
simple call of the function CAN_Initialize for CAN and 
CAN_InitializeFD for CAN FD. Depending on the type of the CAN 
hardware, up to 16 CAN channels can be opened at the same time. 
After a successful initialization the CAN channel is ready. No further 
configuration steps are required. 

Interaction 

For receiving and transmitting messages the functions CAN_Read and 
CAN_Write as well as CAN_ReadFD and CAN_WriteFD are available. 
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Additional settings can be made, e.g. setting up message filters to 
confine to specific CAN IDs or setting the CAN controller to listen-
only mode. 

When receiving CAN messages, events are used for an automatic 
notification of an application (client). This offers the following 
advantages: 

 The application no longer needs to check for received messages 
periodically (no polling). 

 The response time at reception is reduced. 

Completion 

To end the communication the function CAN_Uninitialize is called in 
order to release the reserved resources for the CAN channel, among 
others. In addition the CAN channel is marked as "Free" and is 
available to other applications. 

4.2.3 Notes about the License 

Device drivers, the interface DLL, and further files needed for linking 
are property of the PEAK-System Technik GmbH and may be used 
only in connection with a hardware component purchased from 
PEAK-System or one of its partners. If a CAN hardware component 
of third-party suppliers should be compatible to one of PEAK-
System, then you are not allowed to use or to pass on the driver 
software of PEAK-System. 

If a third-party supplier develops software based on the PCAN-Basic 
and problems occur during the use of this software, consult the 
software provider. 
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5 Frequently Asked Questions 
(FAQ) 

Question Answer 

Can I use several PCAN-
ISA cards in the same 
computer? 

Yes. When there's a lack of resources it 
is possible to share the same interrupt 
between CAN channels. However, 
consider that an unique I/O address 
range is assigned to each CAN channel. 
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6 Technical Specifications 

Connectors  

Computer ISA bus with 8 MHz clock rate, 16 bit bus width 

CAN D-Sub (m), 9 pins 
Pin assignment according to CiA® 303-1 

 

CAN  

Specification ISO 11898-2, High-speed CAN 
2.0A (standard format) and 2.0B (extended format) 

Bit rates 5 kbit/s - 1 Mbit/s 

Controller NXP SJA1000 

Transceiver NXP Philips PCA82C251 

Galvanic isolation up to 500 V (for each CAN connector) 
(only for opto-dec. cards) 

Supplying external 
devices 

PCAN-ISA: D-Sub pin 1/9; 5 V, max. 100mA 
PCAN-ISA opto: D-Sub pin 1/9; 5 V, max. 50mA 
via solder bridge(s), disabled at delivery 

 

Supply  

Current consumption PCAN-ISA Single Channel: max. 150 mA 
PCAN-ISA Dual Channel: max. 170 mA 
PCAN-ISA Single Channel opto-dec.: max. 210 mA 
PCAN-ISA Dual Channel opto-dec.: max. 270 mA 

 

Measures  

Size 143 x 66 x 13 mm (5 5/8 x 2 5/8 x 1/2 inches) 

Weight PCAN-ISA Single Channel: 39 g 
PCAN-ISA Dual Channel: 45 g 
PCAN-ISA Single Channel opto-dec.: 41 g 
PCAN-ISA Dual Channel opto-dec.: 48 g 

 

Environment  

Operating temperature -40 – +85 °C (-40 – +185 °F) 

Temperature for storage 
and transport 

-40 – +125 °C (-40 – +257 °F) 

Relative humidity 15 – 90 %, not condensing 
 



PCAN-ISA – User Manual 
 

34 

Conformity  

EMV Directive 2014/30/EU 
DIN EN 55024:2016-05 
DIN EN 55032:2016-02 

RoHS 2 Directive 2011/65/EU 
DIN EN 50581 VDE 0042-12:2013-02 
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Appendix A CE Certificate 
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Appendix B Quick Reference 

Default setting at delivery 

CAN channel IRQ I/O address range Remark 

1 10 300h – 31Fh  

2 5 320h – 33Fh Only on the Dual Channel version 
 

Hardware Installation / Configuring the Computer 

Install the driver from the supplied DVD. Turn off the computer. 
Insert the card into a free ISA slot (16 bit). After switching on the 
computer, enter the BIOS setup. In the PnP table mark the interrupts 
used by the PCAN-ISA card as reserved. 

Software setup and startup under Windows 

Run the CAN monitor PCAN-View from the Windows Start menu as 
a sample application for accessing the PCAN-ISA card. Indicate the 
needed parameters for initialization of the PCAN-ISA card (I/O base 
address, interrupt) and select the desired CAN channel, when using 
the Dual Channel version. 

High-Speed CAN connector (D-Sub, 9 pins) 
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